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ISDB-T with Tmm Digital Video Test Measurement Details 

Most of the RF transmitter measure-

ments as defined by the ISDB-T 

standard, as well as a wide range of 

additional measurements and analysis 

tools, are available with a press of a 

button. These measurements are fully 

remote controllable via the IEC/IEEE 

bus or LAN, using SCPI commands. 

Analog baseband measurements 

are available on the Keysight 

Technologies, Inc. PXA or MXA 

signal analyzer equipped with BBIQ 

hardware. Supported baseband 

measurements include all of the 

modulation quality plus I/Q waveform 

measurements.

Technology ISDB-T ISDB-TSB ISDB-Tmm

Measurement application N6155A, W6155A N6155A, W6155A N6155A, W6155A

X-Series analyzer PXA, MXA, EXA, 

CXA1

PXA, MXA, EXA, 

CXA1

PXA, MXA, EXA, 

CXA1

Measurements

Channel power

   RF spectrum

   Shoulder attenuation

●

●

●

●

●

Adjacent channel power ● ● ● 2

Spectrum emission mask ● ● ● 2

Power statistic CCDF ● ● ●

Occupied BW ● ● ●

Modulation accuracy

RMS EVM (%) ● ● ●

Peak EVM (%) ● ● ●

Position of peak EVM ● ● ●

RMS MER (dB) ● ● ●

Peak MER (dB) ● ● ●

Position of peak MER ● ● ●

RMS mag error (%) ● ● ●

Peak mag error (%) ● ● ●

Position of peak Mag error ● ● ●

RMS phase error (deg) ● ● ●

Peak phase error (deg) ● ● ●

Position of peak phase error ● ● ●

Frequency error (Hz) ● ● ●

Tx power (dBm) ● ● ●

Quadrature error (deg) ● ● ●

Amplitude imbalance (dB) ● ● ●

In-band spectrum ripple

      Amax-Ac (dB)

      Amin-Ac (dB)

●

●

●

●

●

●

MER/EVM vs. subcarriers/

frequency

● ● ●

MER by layer A/B/C (dB) ● ●

MER by data, pilot, TMCC and 

AC1 (dB)

● ● ●

MER vs. segment ● ● ●

Amplitude vs. subcarriers (dB) ● ● ●

Phase vs. subcarriers (deg) ● ● ●

Group delay vs. subcarriers (ns) ● ● ●

Channel impulse response (dB) ● ● ●

Spectral flatness (dB) ● ● ●

TMCC decoding ● ●

AC decoding ● ●

ISDB-Tmm config ●

1. N6155A operates in the PXA, MXA, and EXA signal analyzers. W6155A operates in the CXA  

 signal analyzer. 

2. This measurement on the ISDB-Tmm signal requires manual configuration.

This demonstration guide 

follows the list on this page, 

which shows the demonstra-

tions included in this document.  

Each demonstration is given 

a brief description of its func-

tion and the corresponding 

measurement steps on the 

signal generator and/or signal 

analyzer.  
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Demonstration Preparation

The following demonstrations use  

the X-Series signal analyzer and  

the MXG N5182A vector signal  

generator. Keystrokes surrounded  

by [ ] indicate front-panel keys; 

keystrokes surrounded by { } indicate 

softkeys located on the display.

Minimum equipment coniguration requirements

Product type Model number Required options

MXG vector  

signal  

generator

N5182A  

(Firmware revision 

A.01.20 or later)

 – 651,652 or 654 – internal baseband  

generator (30 M/60 M/125 MSa/s, 8 MSa)

 – 019 – Upgrade baseband generator memory to 

64 MSa (recommended)

Signal Studio  

for Digital 

Video, ISDB-T 

option

 – N7623B – RFP 

advanced ISDB-T

 – N7623B – MFP 

advanced ISDB-

Tmm (software 

revision 4.1.0.0 or 

later )

Please check N7623B signal studio  

web page for the latest version  

www.keysight.com/find/signal_studio

X-Series  

signal  

analyzer

N9000A, N9010A, 

N9020A, or N9030A 

firmware revision 

A.08.xx or later

Recommended:

 – EA3 – Electric attenuator, 3.6 GHz

 – POx – Preamplifier

 – P0x (P03, P08 (P07 for CXA))

 – BBA – Analog baseband IQ inputs (for analog 

baseband IQ analysis)

Required:

 – 503, 508,  507, (EXA and CXA), 513 or 526–513 

and 526 not available on CXA

 – B25 – Analysis bandwidth, 25 MHz

ISDB-T  

measurement 

application

N6155A – N9010A,  

N9020A, N9030A

W6155A – N9000A 

only

Required:

 – 2FP: ISDB-T measurement application,  

fixed perpetual license

 – 3FP: ISDB-Tmm measurement application, fixed 

perpetual license

OR

 – 2TP: ISDB-T measurement application,  

transportable license (Only for PXA/MXA/EXA)

 – 3TP: ISDB-T measurement application,  

transportable license (Only for PXA/MXA/EXA)

Controller PC  

for Digital 

Video  

Signal Studio1

 

Install N7623B to generate and download the 

signal waveform into the Keysight MXG via GPIB 

or LAN (TCP/IP)—please refer to the online 

documentation for installation and setup

1. Keysight X-Series PXA/MXA/EXA/CXA signal analyzers can be used as the controller PC to install  

 the N7623B Signal Studio software and download waveforms into the MXG via LAN or GPIB.

Helpful tip:

Update your instrument firmware and software  

to the latest version, available at

www.keysight.com/find/xseries_software and

www.keysight.com/find/signalstudio

http://www.keysight.com/find/signal_studio
http://www.keysight.com/find/xseries_software
http://www.keysight.com/find/signalstudio


4

N7623B Digital 

Video Signal Studio

10 MHz Ref

LAN/GPIB

MXG 

RF 

Out

X-Series

signal 

analyzer 

RF In

Figure 1. Demonstration setup 

Demonstration Setup

Connect the PC, X-Series, and MXG

Connect a PC (loaded with Keysight 

N7623B Signal Studio for Digital Video  

software and Keysight I/O libraries) 

to the N5182A MXG via GPIB or LAN. 

Follow the Signal Studio instructions 

to complete the connection, and 

then perform the following steps 

to interconnect the X-Series signal 

analyzer (see Figure 1 for a graphical 

overview):

A. Connect the MXG RF Output port 

to the X-Series signal analyzer RF 

Input port

B. Connect the MXG 10 MHz Out to 

the X-Series signal analyzer Ext 

Ref In port (rear panel)
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Demonstrations

Demonstration 1: 

Set up ISDB-T/ISDB-Tmm 
Digital Video Signal Studio 
on MXG

The Keysight N7623B Signal Studio 

for Digital Video is a Windows-based 

utility that simplifies the creation 

of standards-based or customized 

digital video signals. The waveform 

is downloaded into the MXG vector 

signal generator, which generates RF 

or IQ signals.

Instructions  Keystrokes

On the MXG

Preset the MXG
Check the IP address

[Preset]
[Utility] {I/O Config} {LAN Setup}

On the Signal Studio software

Run the Keysight Signal Studio for 
Digital Video

Double-click on the Digital Video shortcut on the desktop 
or access the program via the Windows start menu

Verify the software is communicating 
with the instrument via the GPIB or 
LAN (TCP/IP) link

To establish a new connection, click on the {System} pull-
down menu at the top of the Signal Studio program win-
dow. Next, select {Run System Configuration Wizard}.

To generate ISDB-T signals

Select the ISDB-T format
Click on the {Format} pull-down menu at the top of the 
Signal Studio program window. Next, select {ISDB-T}

Set the parameters of the signal 
generator with center frequency 
713.142857 MHz, amplitude   
–20 dBm, RF output turned On, and 
ALC On

Click Signal Generator at the left on the Explorer menu.  
Instrument Model Number: N5162A/N5182A 
Press [Preset] green button on the top. 
Frequency = 713.142857 MHz, Amplitude = –20 dBm,  
RF Output = On, ALC = On

Confirm the waveform setup from 
upper level

Click Waveform Setup to see the fundamental waveform
signal setups. The default settings are used in this demo.

Configure a test signal for  
demonstrations

Click Carrier0 under Waveform Setup on the left of the 
Explorer menu to see the setups on Carrier0, set the 
parameters for each layer as follows and leave the others 
as default.
 – Layer A: 1 Segment; Code Rate = 2/3; QPSK; I (Time 
Interleaving length) = 4

 – Layer B: 4 Segment; Code Rate = 3 /4; 64QAM; I = 2
 – Layer C: 8 Segment; Code Rate = 5/6; 16QAM; I = 4

Then select AC Builder Tool in the AC setup cell and 
configure the earthquake alarm information using the AC 
Builder in the AC cell. 
Figure 2 shows the look of the window after the ISDB-T 
setup finishes.

To Generate ISDB-Tmm signals

Select the ISDB-Tmm format
Click on the {Format} pull-down menu at the top of the
Signal Studio program window. Next, select {ISDB-Tmm}.

Set the parameters of the signal 
generator with center frequency 
214.714286 MHz, amplitude  
–20 dBm, RF output turned On, and 
ALC On

Click Signal Generator at the left on the Explorer menu.
Instrument Model Number: N5162A/N5182A
Press [Preset] the green button on the top.
Frequency = 214.714286 MHz, Amplitude = –20 dBm,
RF Output = On, ALC = On

Confirm the waveform setup from 
upper level

Click Waveform Setup to see the fundamental waveform 
signal setups. The default settings are used in this demo.

Configure a test signal for  
demonstrations

Click Carrier0 under Waveform Setup on the left of the 
Explorer menu to set the parameters of the ISDB-Tmm 
signal, and then click Super Segment x and 1-seg x  
(if the super segment type is type B) to configure the 
ISDB-Tmm frame. 
In this demo, the default settings, which are compliant to 
the configuration A defined in the ISDB-Tmm operational 
guide, are used.

Download the signal to the MXG
Click  (generate and download button) on the top tool 
bar. If you encounter any errors, please refer to the online 
help in the Signal Studio software

Save the signal file for future use File > Save Setting File > ISDB.scp (name it)

Export the waveform file for future use File > Export Waveform Data > ISDB.wfm (name it)
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Figure 2. ISDB-T/T
SB

 signal setup in the Keysight Signal Studio software

Figure 3. ISDB-Tmm signal setup in the Keysight Signal Studio Software
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Demonstration 2:

Channel power 

The channel power measurement  

has two views: RF spectrum and 

shoulder attenuation. 

 – RF spectrum view measures and 

reports the integrated power in 

an ISDB-T defined bandwidth 

and power spectral density (PSD) 

displayed in dBm/Hz or dBm/MHz.

 – Shoulder attenuation view  

measures shoulder attenuation 

compliant with the ISDB-T standard.

Figure 4 Channel power measurement with RF spectrum view 

Figure 5. Channel power measurement with shoulder attenuation view

Instructions  Keystrokes

On the X-Series signal analyzer:

Preset the signal analyzer [Mode Preset]

Select ISDB-T mode [Mode] {ISDB-T}

Choose ISDB-T standard [Mode Setup] {Radio Std} {ISDB-T}

Set a center frequency at 713.142857 MHz
[FREQ Channel] {Center Freq} 

{713.142857} {MHz}

Select channel power measurement  

(RF spectrum default)
[Meas] {Channel Power}

Switch to shoulder attenuation view [View/Display] {Shoulder Attenuation}

Helpful tip:

To make RF spectrum 

and shoulder attenuation  

measurements according 

to the ISDB-T
SB

 

standard, change 

the integration BW, 

shoulder offset start, 

and shoulder offset stop 

values under the meas 

setup menu manually 

as needed.during the 

demonstration.
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Demonstration 3:

Adjacent channel  
power (ACP)

The ACP test verifies the ability of 

the modulator or transmitter to limit 

the interference produced by the 

transmitted signal to other receivers 

operating in the adjacent in-band or 

adjacent out-band RF channel. The 

limit can be defined to measure the 

power in adjacent channels relative  

to the transmitted power.

The ACP measurement results should 

look like Figure 6. The text window 

shows the power in the adjacent 

channels.

Figure 6. ACP measurement with noise correction on

Instructions  Keystrokes

On the X-Series signal analyzer:

Activate adjacent channel power (ACP) 

measurement
[Meas] {ACP} {More 1 of 2}

Compare the measurement result with 

noise correction turned on (default is off). 

A better ACP result is achieved with noise 

correction on (Figure 6)

[Meas Setup] {More 1 of 3} {More 2 of 3}  

{Noise Correction On}

Helpful tip:

To make the adjacent 

channel power measure-

ment according to ISDB-

Tmm standard, change 

the settings under the 

Meas Setup menu 

manually, as needed.
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Demonstration 4: 

Power stat CCDF

The power stat complementary  

cumulative distortion function (CCDF)  

is a statistical method used to inter-

pret the peak-to-average ratio of  

digitally modulated noise-like signals.  

It is a key tool for the power ampliier  

design in ISDB-T/T
SB

/Tmm transmit-

ters, which is particularly challenging 

because the ampliier must be 

capable of handling the high peak-

to-average ratio while maintaining 

good adjacent channel leakage 

performance. 

Figure 7. Power stat CCDF measurement

Figure 8. Power stat CCDF measurement with reference trace

Instructions Keystrokes

On the X-Series signal analyzer:

Activate the power stat CCDF measurement [Meas] {Power Stat CCDF}

Store a reference trace [Trace/Detector] {Store Ref Trace}

Turn on reference trace [Trace/Detector] {Ref Trace On}
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Demonstration 5: 

Spectrum emission mask

The spectrum emission mask (SEM) 

measurement can compare the total 

power level within the defined car-

rier bandwidth and the given offset 

channel on both sides of the carrier 

frequency to levels allowed by the 

ISDB-T/T
SB

/Tmm standard. This 

measurement rebounds to the design 

of the power amplifier in the ISDB-T/

T
SB

/Tmm transmitter, and it is a key 

measurement linking amplifier  

inearity and other performance  

characteristics to the stringent  

system specifications.

During the SEM measurement  

process, the amplitude correction 

function is employed to address situa-

tions where the dynamic range of the 

input signal may be larger than that of 

the signal analyzer. For more details, 

refer to Appendix A.

To support all spectrum limits defined 

in ISDB-T/T
SB

 standards, six limit 

types are available under the Meas 

Setup, Limit Type panel, as follows: 

 – Manual

 – JEITA: defined in ARIB STD B31

 – ABNT non-critical:  

defined in ABNT NBR 15601

 – ABNT sub-critical:  

defined in ABNT NBR 15601

 – ABNT critical:  

defined in ABNT NBR 15601

 – ISDB-T
SB

: defined in ARIB STD B29

For JEITA limit type, there are another 

four options (auto sense, 30 dB mask, 

40 dB mask, and 50 dB mask) that 

enable you to set the spectrum mask 

compliant with ARIB STD B31 version 

1.7. For more details about ARIB STD 

B31 V.17 spectrum mask definition, 

use case, and settings in the N6155A 

and W6155A SEM measurement, 

refer to Appendix B.

Instructions Keystrokes

On the X-Series signal analyzer:

Activate spectrum emission mask [Meas] {Spectrum Emission Mask}

Input the value of the attenuator  

(for the actual ISDB-T transmitter)
[Input/Output] {External Gain} {Ext Preamp}

Recall or edit the correction table
[Input/Output] {More 1 of 2} {Corrections} 

{Edit} or [Recall] {Data}

Turn correction on [Input/Output] {More 1 of 2} {Corrections} {On}

Select the limit type [Meas Setup] {Limit Type} {JEITA} {Auto  Sense}

Figure 9. Spectrum emission mask measurement after amplitude correction

Helpful tips:

To get the format of the file to be recalled, first edit  

several points using the onscreen editor, then press Save,  

Data (Export) Correction 1, Save As... to save the  

correction data to a file. Open the file and view the format.

To measure the spectrum mask on ISDB-Tmm signals, 

you need to use the Manual limit type and specify the 

spectrum mask by setting the parameters under Meas 

Setup, Ref Channel and Meas Setup, Offset/Limit 

manually.
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Demonstration 6: 

Modulation accuracy

The modulation accuracy measure-

ment is necessary to perform the 

ISDB-T-defined tests and to ensure 

proper operations. It provides the 

EVM, MER, magnitude error, phase 

error, frequency error, quadrature 

error, amplitude imbalance, channel 

frequency response, and channel 

impulse response results for ISDB-T/

TSB/Tmm signals. Additionally, for 

ISDB-T/TSB signals, you can measure 

the EVM/MER results on each layer 

or segment in I/Q error view, TMCC 

decoding results in the TMCC decod-

ing view, and AC decoding results 

in AC decoding view which lists the 

earthquake information carried in the 

AC bits. For ISDB-Tmm signals, you 

can measure the EVM/MER results 

on each super segment, layer, or 

segment and check the ISDB-Tmm 

configurations for the current signal 

in the ISDB-Tmm config view.

The procedure for and the results 

from making modulation accuracy 

measurements on ISDB-T/TSB and 

ISDB-Tmm signals are different and 

are introduced separately in this demo.

To make modulation accuracy  
measurements on ISDB-T/TSB signals

Instructions  Keystrokes

On the X-Series signal analyzer:

Select the radio standard and Channel BW
[Mode Setup] {Radio Std} {ISDB-T}

[Mode Setup] {Channel BW} {6 MHz}

Activate the modulation accuracy  

measurement
[Meas] {Mod Accuracy}

Select demodulation options; there are  

two methods

[Mode Setup] 

Select the demodulation options under this 

menu according to the transmitted signal’s 

format or 

[Meas Setup] {Auto Detect}

View the I/Q measured polar graph

(Figure 11)

[View/Display] {I/Q Measured Polar 

Graph}

Switch to the I/Q error view (Figure 12) [View/Display] {I/Q Error (Quad View)}

View the channel frequency response  

(Figure 13)

[View/Display] {Channel Frequency 

Response}

View the channel impulse response and turn 

on the equalizer (Figure 14)

[View/Display] {Channel Impulse Response}  

[Meas Setup] {Advanced} {Equalization} On

View the spectrum flatness (Figure 15) [View/Display] {Spectrum Flatness}

View the TMCC decoding results  

(Figure 16)
[View/Display] {TMCC Decoding}

View the AC decoding results (Figure 17) [View/Display] {AC Decoding}

View the MER vs. Segment results  

(Figure 18)
[View/Display] {MER vs. Segment}

View result metrics (Figure 19) [View/Display] {Result Metrics}

Figure 10. Channel impulse response view with multi-paths

Helpful tip:

The peak table window 

in the channel impulse 

response view is very 

helpful in identifying the 

multi-paths existing in 

the channel. Figure 10 

is an example of a four-

path channel with 0, 10,  

20, and 30 µs delay 

respectively.



12

Figure 11. Modulation accuracy measurement with I/Q measured polar graph view

Figure 12. Modulation accuracy measurement with I/Q error view

Available views and traces in  

modulation accuracy:

 – I/Q measured polar graph view 

(Figure 11): A view of I/Q measured 

data of the selected sub-carriers

 – Results metrics (left)

 – I/Q measured polar graph (right)

 – I/Q error view (Figure 12):  

This is a four-window view which 

includes:

 – MER/EVM vs. sub-carrier/

frequency (top left)

 – Segment map (top right)

 – Data segment/layer polar graph 

(bottom left)

 – Results metrics (bottom right)

Helpful tip:

In I/Q Error view, you can see the measurement results 

of each layer or segment by setting the display type. 

Four windows are displayed in Figure 12. The MER 

versus sub-carrier (top-left) window displays the MER 

result for the entire frame. The segment map window 

(top right), datasegment/layer polar graph window 

(bottom left), and result metrics window (bottom right) 

indicate the results for the selected display data.
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Figure 13. Modulation accuracy measurement with channel frequency response view

Figure 14. Modulation accuracy measurement with channel impulse response view

 – Channel frequency response view 

(Figure 13): This is a three-window 

view which includes:

 – Amplitude vs. sub-carrier (top)

 – Phase vs. sub-carrier (middle)

 – Group delay vs. sub-carrier  

(bottom)

 – Channel impulse response view 

(Figure 14): This two-window view 

displays the state of the channel in 

time domain which the signal has 

gone through.

 ◦ Peak table (left)

 ◦ Amplitude vs. time (right) 
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Figure 16. Modulation accuracy measurement with TMCC decoding view  

The results in yellow with the title ‘Current’ show the current hierarchical 

configuration and transmission parameters, while the results in purple with 

the title ‘Next’ show the information for the next hierarchical configuration. 

The results in white in the right-most row indicate the current settings 

under mode setup, demod.

Figure 17. Modulation accuracy measurement with AC decoding view 

Figure 15. Modulation accuracy measurement with spectrum flatness view

 – Spectrum flatness view (Figure 15): 

This two-window view can be used 

to verify whether the spectrum 

flatness meets the transmitter 

or exciter device standard with a 

PASS/FAIL indicator and shows:

 – Amplitude vs. sub-carrier (top)

 – Results metrics (bottom)

 – TMCC decoding view (Figure 16): 

This view displays TMCC decoding 

results and the corresponding  

current settings.

 – AC decoding view (Figure 17):  

This view displays the earthquake 

alarm information carried in the  

AC bits.
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Figure 19. Modulation accuracy measurement with results metrics view 

Figure 18. Modulation accuracy measurement with MER vs. Segment view

 – MER vs. Segment view (Figure 18): 

This view displays the MER result 

of each segment. The segment 

indexes numbered 13 to 32 are 

designed for  ISDB-Tmm signals,  

so when the signal under test is  

an ISDB-T signal, the MER results 

for these indexes are all displayed 

as “---”.

 – Result metrics view (Figure 19): 

This view displays the summary 

of all the detailed numeric result 

metrics.

Helpful tip:

You can check the MER results using all the sub-

carriers, layer A/B/C, data, pilot, TMCC, and AC1 in 

the result metrics view.
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To make modulation accuracy  
measurements on ISDB-Tmm signals

Instructions  Keystrokes

On the X-Series signal analyzer:

Select ISDB-Tmm standard [Mode Setup] {Radio Std} {ISDB-Tmm}

Select the modulation accuracy  

measurement
[Meas] {Mod Accuracy}

If the signal under test is not compliant with 

the configuration A defined in the ISDB-Tmm 

operation guideline, import the configuration 

file 1 into the instrument. 

[Recall] {Data} {ISDB-Tmm Config} 

{Open ...} 

View the I/Q measured polar graph results 

(Figure 20)
[View/Display] {I/Q Measured Polar Graph}

View the I/Q error results (Figure 21) [View/Display] {I/Q Error (Quad View)}

View the channel frequency response results 

(Figure 22)

[View/Display] {Channel Frequency 

Response}

View the channel impulse response results 

(Figure 23)
[View/Display] {Channel Impulse Response}

View the spectral flatness results (Figure 24) [View/Display] {Spectral Flatness}

View the frame configuration of the current 

ISDB-Tmm signal (Figure 25)
[View/Display] {ISDB-Tmm Config}

View the MER vs. Segment results (Figure 26) [View/Display] {MER vs. Segment}

View the result metrics (Figure 27) [View/Display] {Result Metrics}

1. The configuration file needs to be created according to the configuration of the Tmm signal  

 under test. The configuration file of the default settings, named “ISDB-TmmConfig_Demo.csv”  

 and located in the directory “D:\User_My_Documents\Instrument\My Documents\ISDBT\ 

 data\EVM”, can be used as an example.

Available views and traces in 

modulation accuracy for ISDB-Tmm 

signals:

 – I/Q measured polar graph view 

(Figure 20): A view of I/Q measured 

data of the specified sub-carriers

 – Result metric (left)

 – I/Q measured polar graph (right)

Figure 20. I/Q measured polar graph view for ISDB-Tmm signals



17

 – I/Q error (Quad View) view 

(Figure 21): This is a four-window 

view which includes

 – MER/EVM vs. sub-carrier/

frequency (top left)

 – ISDB-Tmm frame structure  

(top right)

 – I/Q Measured Polar Graph  

(bottom left)

 – Results metrics (bottom right)

 – Channel frequency response view 

(Figure 22): This is a three window 

view which includes:

 – Amplitude vs. sub-carrier (top)

 – Phase vs. sub-carrier (middle)

 – Group delay vs. sub-carrier  

(bottom)

Figure 21. IQ error (Quad View) view for ISDB-Tmm signals

Figure 22. Channel frequency response view for ISDB-Tmm signals

Helpful tip:

Press I/Q Error (Quad View) again and then set 

the data to display on the screen using the keys in 

the menu. You can choose to see the results for a 

specified super segment, segment, or layer in a type 

A super segment.
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Figure 23. Channel impulse response view for ISDB-Tmm signals

Figure 24. Spectrum flatness view for ISDB-Tmm signals

Figure 25. ISDB-Tmm config view for ISDB-Tmm signals

 – Channel impulse response view 

(Figure 23): This two-window view 

displays the state of the channel in 

time domain which the signal has 

gone through. 

 – Peak table (left)  

 – Amplitude vs. time (right)

 – Spectrum flatness view (Figure 24): 

This two-window view shows  

the spectrum ripples in the  

transmission bandwidth. 

 – Amplitude vs. sub-carrier (top)

 – Result metrics (bottom)

 – ISDB-Tmm Config view (Figure 25): 

This view shows the configurations 

of each super segment of the  

ISDB-Tmm signal under test.

Helpful tip:

Press ISDB-Tmm Config 

again and enter the super 

segment index to view 

the configuration for a 

specified super segment.
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 – MER vs. segment view (Figure 26): 

This view shows the MER result on 

each segment.

 – Result metrics view (Figure 27): 

This view displays the summary 

of all the detailed numeric result 

metrics. 

Figure 26. MER vs. Segment view for ISDB-Tmm signals

Figure 27. Result metrics view for ISDB-Tmm signals
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Demonstration 8: 

Monitor spectrum

The monitor spectrum measurement 

is used as a quick, convenient means 

of looking at the entire spectrum. 

While the look and feel is similar 

to the spectrum analyzer mode, the 

functionality is greatly reduced for 

easy operation. The main purpose 

of the measurement is to show the 

spectrum.

Instructions Keystrokes

On the X-Series signal analyzer:

Activate monitor spectrum measurement [Meas] {Monitor Spectrum }

Figure 29. Monitor spectrum measurement

Demonstration 7: 

Occupied bandwidth

The ISDB-T specifications require the 

occupied frequency bandwidth of the 

ISDB-T signal to be less than 5.7 MHz. 

The occupied frequency bandwidth is 

defined as the bandwidth containing 

99% of the total power.

Instructions Keystrokes

On the X-Series signal analyzer:

Measure the occupied bandwidth (Figure 28) [Meas] {Occupied BW}

Adjust the parameters [Meas Setup]

Figure 28. Occupied bandwidth measurement 
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Demonstration 9: 

IQ waveform

The IQ waveform measurement is a 

generic measurement for viewing the 

input signal waveforms in the time 

domain. Under this measurement 

there is also an I/Q waveform win-

dow, which shows the I and Q signal 

waveforms in parameters of voltage 

versus time to disclose the voltages 

that comprise the complex modulated 

waveform of a digital signal. The 

waveform measurement can be used 

to perform general-purpose power 

measurements to a high degree of 

accuracy as well. 

Instructions Keystrokes

On the X-Series signal analyzer:

Activate IQ waveform measurement

(RF envelope default)
[Meas] {IQ Waveform}

View the I/Q waveform [View/Display] {I/Q Waveform}

Figure 30. Waveform measurement with RF envelope view

Figure 31. Waveform measurement with I/Q waveform view
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Appendix A:

Using amplitude correction in the 

spectrum emission mask measurement

The dynamic range of the RF output 

of an actual ISDB-T/T
SB

 transmitter 

typically exceeds the dynamic range 

of the analyzer. Therefore, the direct 

measurement result is always “FAIL” 

and cannot reflect the actual RF 

output. 

To measure the spectrum mask of  

the transmitter’s RF output, there are 

two methods.

Exciter
Power 

ampliier
External 

ilter
Input 

signal

Signal 

analyzer
Attenuator

ISDB-T/T
SB

 transmitter (UUT)

RF output B

Figure 32. Diagram for spectrum mask measurement on ISDB-T/T
SB

 transmitter with mask filter

Figure 33. Diagram for spectrum mask measurement on an ISDB-T/T
SB

 transmitter without  

output filter

Method 1: Figure 32 shows a diagram 

of the spectrum mask measurement 

when the ISDB-T/T
SB

 transmitter has 

an output filter. 

The steps for measuring the spectrum 

mask are as follows:

1. Measure the frequency response 

of the output ilter using a net-

work analyzer or a combination of 

signal source and signal analyzer.

Exciter
Power  

ampliier
Input 

signal

Signal 

analyzer
Attenuator

ISDB-T/T
SB

 transmitter (UUT)

RF output

A Mask 

ilter

2. Measure the signal transmitted at 

point A as shown in Figure 32.

3. Apply amplitude correction on the 

spectrum value measured in (2) 

using the ilter’s response from (1).

The correction data is typically a table 

of the filter’s frequency response, in 

dB, at a number of frequency points 

across the band.

 

Method 2: If the transmitter does not 

have an output filter, an external filter 

with a band-block filter frequency 

response should be added after the 

transmitter for the measurement 

arrangement, as shown in Figure 33. 

The steps for measuring the spectrum 

mask are as follows:

1. Measure the frequency response 

of the output ilter using a net-

work analyzer or a combination of 

signal source and signal analyzer.

2. Measure the signal transmitted  

at point B as shown in Figure 33.

3. Apply amplitude correction on the 

spectrum value measured in (2) 

using the ilter’s response from (1).

The correction data is typically a 

table of the negative values of the 

filter’s frequency response, in dB, at 

a number of frequency points across 

the band.
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Appendix B:

The transmission spectrum mask 

defined in ARIB STD B31 (Version 1.7)

The ISDB-T transmission-spectrum 

mask defined in ARIB STD B31 is 

shown in Figure 34 and the related 

breakpoints are listed in Table 1.

Different spectrum masks should 

be applied if the following factors 

change:

 – Whether an adjacent channel is 

used for analog TV or not

 – Whether the power in the adjacent 

channel is more than or equal to  

10 times the ISDB-T channel  

power or not

To correctly apply the spectrum mask 

in N6155A SEM measurement, follow 

the actions in Table 2 according to 

each use case.

Figure 34. Transmission-spectrum mask for ISDB-T in ARIB STD B31 (Version 1.7)
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Table 1. Breakpoints for the transmission-spectrum mask

Difference from the 

center frequency (MHz)

Attenuation relative to average power P 

(dB/10 kHz)

Type of  

stipulation

± 2.79 –27.4 Upper limit

± 2.86 –47.4 Upper limit

± 3.00 –54.4 Upper limit

± 4.36 –77.4/–67.4/–57.4/–(73.4+10logP) Upper limit

Table 2. Actions required for compliance with the spectrum mask in ARIB STD B31 (Version 1.7)

Channel 

power P

Is adjacent 

channel used 

for analog TV?

Does the analog 

TV have more 

than or equal 

to 10 times the 

channel power?

Offset D limit 

(±(4.36~15)  

MHz from carrier  

frequency) 

(dB/10 KHz)

Mask under 

JEITA to be 

used

P > 2.5 W Yes/No Yes/No –77.4 Auto sense

2.5 W ≥ P > 

0.25 W

No Yes/No –(73.4+10logP) Auto sense

Yes Yes –(73.4+10logP) Auto sense

Yes No –77.4 50 dB mask

0.25 W ≥ P 

> 0.025 W

No Yes/No –(73.4+10logP) Auto sense

Yes Yes –67.4 40 dB mask 

Yes No –77.4 50 dB mask

0.025 W ≥ P

No Yes/No –57.4 Auto sense

Yes Yes –67.4 40 dB mask

Yes No –77.4 50 dB mask
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Web Resources

Product page:  

www.Keysight.com/find/n6155a and  

www.Keysight.com/find/w6155a

X-Series signal analyzers:  

www.Keysight.com/find/X-Series

X-Series advanced measurement applications:  

www.Keysight.com/find/X-Series_Apps

Digital video industry web page: 

www.Keysight.com/find/digitalvideo

Signal Studio software:  

www.Keysight.com/find/SignalStudio

Signal generators:  

www.Keysight.com/find/sg

Digital video solution table:

www.Keysight.com/find/digitalvideo_solution

http://www.Keysight.com/find/n6155a
http://www.Keysight.com/find/w6155a
http://www.Keysight.com/find/X-Series
http://www.Keysight.com/find/X-Series_Apps
http://www.Keysight.com/find/digitalvideo
http://www.Keysight.com/find/SignalStudio
http://www.Keysight.com/find/sg
http://www.Keysight.com/find/digitalvideo_solution
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